
PDF CREATION
GUIDE

YOUR GUIDE TO CREATING & EXPORTING 

USING ADOBE
®

 InDesiGN
®

 OR Photoshop
®  



This manual includes all of the steps necessary to create a fantastic yearbook by submitting your yearbook files 
in PDF format. PDFs eliminate many of the problems associated with delivering print-ready desktop publishing 
files. Programs such as Adobe® InDesign® and Adobe® Photoshop® easily export documents into this format and 
have been cornerstones of professional printing.

Please read and follow the instructions very carefully to avoid delays in the delivery of your yearbooks. 
Previous experience with page layout software is highly recommended for this plan.

If you are using other versions that are not supported in this manual, please contact us at  
graphics@walterspublishing.com.

Adobe, the Adobe logo, Photoshop and InDesign are either registered trademarks or trademarks of Adobe Systems Incorporated in the  
United States and/or other countries. All other trademarks are the property of their respective owners.

INSIDE:
	 •   �CD containing cover templates, document templates and our preferred export & color settings files.
	 •   �DVD containing artwork and fonts!
	 •   �Step-by-step instructions for loading our PDF export and color settings to your Adobe software.
	 •   �Step-by-step instructions for creating your PDF files.
	 •   �Helpful tips on using provided artwork and fonts to create a theme for your book.
	 •   �Information about submitting your finished book.
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Acceptable Programs  
We offer instructions in this guide that detail the procedures used to create PDF files with the 
following programs: 
•   �Adobe® InDesign® CS3-Creative Cloud
•   �Adobe® Photoshop® CS3-Creative Cloud 

If you’re attempting to use other page layout programs, or older versions than those listed above, we cannot 
guarantee that your files will reproduce the way you’ve created and viewed them on your screen. We do not offer 
assistance for any unlisted programs, and do not supply any software. If you have questions about your software 
and how it creates PDF documents please contact the manufacturer of your software. 

Document Templates
We HIGHLY recommend you use our document templates for InDesign and Photoshop found on the enclosed 
PDF Creation CD. Using one of our templates lets you easily create your yearbook at the proper size with 
appropriate guides and settings to keep you on the right track. 

Read the Instructions

You will find PDF CREATION INSTRUCTIONS on pages 8-10; follow these instructions carefully. Important 
settings files are included in the enclosed PDF Creation CD. The Color Settings and PDF Export Settings files on 
this CD must be installed if you plan to submit PDF files.

TEST PAGES

Included on the PDF Creation CD you will find a color target test image to include in your test pages. It’s also 
beneficial to include some of your own photos and styled text in these pages for testing. Send 2-4 pages of 
your book with the supplied target test image to graphics@walterspublishing.com 

PDF testing must be done as early as possible and approved before your yearbook can be submitted.

Yearbook Covers
Choose a Stock Cover or Design Your Own Custom Cover.
•   �Custom covers must be submitted before the rest of your book.
•   �Cover deadlines are February 1ST for yearbooks shipping before June 30 and August 1ST for yearbooks 

shipping July 1 to December 31.
•   �Stock covers allow you to print your title in the color shown for FREE. See the Stock Cover Guide for choices. 

Please note: stock cover art cannot be altered.

Page Count

•   �Yearbook page counts must be divisible by 4 (e.g,. 24 or 32 pages, but not 22 or 30 pages). Your total page 	  
count does not include the outside cover, the inside front or inside back cover; only interior pages. 

•   �Smyth Sewn yearbook page counts must be divisible by 16.

Autograph & Current Events Pages
You can add Stock Autograph Pages (extra charge) or Current Events Pages to your yearbook. Indicate your 
design and placement selections on the Production Form. Stock Autograph pages are not included in your 
total page count and are not numbered. Current Events pages should be included in your total page count, 
but will not be numbered. Current Events pages will be added to the back of your book, unless otherwise 
specified on the Production Form. Current Events pages will not be billed separately. Your yearbook price will 
be based on total page count (including Current Events pages).

We cannot process your yearbook without a completed Production Form!

Follow the instructions in this guide carefully. Yearbooks not within these guidelines may be returned 
for rework and will be rescheduled. This will delay shipment.

If you have questions, please contact Customer Care at 1-800-447-3274. We are happy to help!2
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USE THE PROGRAM TEMPLATES INCLUDED ON 
THE PDF CREATION CD (Includes Adobe InDesign® 
and Photoshop®). 

8.5x11 Book Size Specs: 8.5"x11" with additional 
0.125" (1/8") bleed on all 4 sides and in single-page 
layout mode. Facing pages format is allowed only if 
the book is submitted as a PDF. Create PDFs of single 
pages and test (e-mail us a test file) before 
submitting the files for publishing. E-mail test pages 
and questions to graphics@walterspublishing.com. 

9x12 Book Size Specs: 9"x12" with additional 0.125" 
(1/8") bleed on all 4 sides and in single-page layout 
mode. Facing pages format is allowed only if the 
book is submitted as a PDF. Create PDFs of single 
pages and test (e-mail us a test file) before 
submitting the files for publishing. E-mail test pages 
and questions to graphics@walterspublishing.com.

BLEED: Artwork, photos or page elements that are to 
bleed (extend to the edge of the page with no 
margin) must be set up 0.125" (1/8") beyond page 
edges on all sides of the page. This bleed will be 
trimmed off. Program templates are preset with a 
bleed box on each page (sized to 8.75"x11.25" for an 
8.5"x11" book). Backgrounds either need to bleed 
0.125" (1/8") beyond page edges or be within the 
0.5" (1/2") page margin.

PAGE MARGINS: All important text and images that 
you do not want to risk being trimmed off or lost in 
the binding should be kept within the 0.5" (1/2") 
safety margins on the templates. This is particularly 
important for standard hard cover books.

HARD COVER BINDING OPTIONS: There are two 
types of hard cover bindings available. Smyth binding 
is strongly recommended for books that have photos 
or text that span across two pages or that have text 
and/or images that are less than 1/4" from the trim 
line on the interior (gutter) side of the book. Standard 
Hard Cover binding works best when a book has 
been designed with all text and images at least 1/2" 
from the trim lines. 

PDF SIZE AND NAMING CONVENTIONS: A PDF 
book may be submitted in whatever section sizes you 
would like (1 page, 4 page, 16 page, entire book). 
PDF files should be named in a manner that clearly 
indicates the job number and page number; e.g., 
jobnumber_001-016.pdf.

PAGE NUMBERS: Each page in your yearbook must 
include a page number! Page numbers should be 
included on all PDF files.

SAVING AND NAMING IMAGES: Images should be 
saved in a folder on your computer and each image 
should have a unique name for linking purposes.  

File names should not be changed unless you re-link 
the images after the name change. Renaming images 
or moving them to a different folder or CD could 
cause missing link problems later on when you are 
exporting your PDF files.

PAGE TEMPLATE LIBRARIES are included on the 
enclosed CD for use in InDesign. 

FONTS are provided on the Artwork DVD for your 
unlimited use. If you choose to use custom fonts, 
include them with your files when the job is 
submitted; or submit your book as PDF files with all 
fonts embedded. 

TO INSTALL STOCK FONTS ON A MAC, copy all 
fonts from the Artwork DVD into your System Fonts 
folder. Restart your computer to activate them. 

TO INSTALL STOCK FONTS ON A WINDOWS PC, go 
to the Start menu, choose Control Panel, and open 
the font folder inside. Install all fonts from the 
Artwork DVD into the font folder by choosing File 
and Import New Font until all yearbook fonts have 
been loaded.

DO NOT USE FONT MENU STYLES ON A 
WINDOWS COMPUTER. You may bold or italicize a 
font ONLY if you have the bold or italic version of 
that font.

STOCK ARTWORK IS PROVIDED ON THE 
ARTWORK DVD FOUND ON THE INSIDE BACK 
COVER OF THIS GUIDE. Backgrounds are provided as 
.jpg files and clip art is provided as .png files. Clip art 
(.png files) may not be compatible with all versions of 
publishing software. 

TWO-PAGE SPREADS: If you choose to include two-
page spreads in your book, just create your book as 
facing pages and create single-page PDF files when 
you export your book. Check your PDF files before 
submitting to make sure that they split correctly and 
that the bleeds extend on all four sides. If you need 
help with this, please contact  
graphics@walterspublishing.com.

CUSTOM COVERS: Submit a separate CD/DVD/USB 
Drive containing your custom cover with the 
completed Custom Cover Form by February 1ST for 
books shipping before June 30TH, or August 1ST for 
books shipping July 1ST to December 31ST. Our custom 
cover templates must be used for custom cover 
submission (see the Custom Cover Instruction Guide). 
Templates vary according to binding type and page 
count. Choose the correct cover template based on 
these criteria.

SEND TEST FILES early in the school year. We can 
verify that you are on the right track with program 
settings and image resolution. E-mail test file to 
graphics@walterspublishing.com.

Acceptable Programs  
We offer instructions in this guide that detail the procedures used to create PDF files with the 
following programs: 
•   �Adobe® InDesign® CS3-Creative Cloud
•   �Adobe® Photoshop® CS3-Creative Cloud 

If you’re attempting to use other page layout programs, or older versions than those listed above, we cannot 
guarantee that your files will reproduce the way you’ve created and viewed them on your screen. We do not offer 
assistance for any unlisted programs, and do not supply any software. If you have questions about your software 
and how it creates PDF documents please contact the manufacturer of your software. 

Document Templates
We HIGHLY recommend you use our document templates for InDesign and Photoshop found on the enclosed 
PDF Creation CD. Using one of our templates lets you easily create your yearbook at the proper size with 
appropriate guides and settings to keep you on the right track. 

Read the Instructions

You will find PDF CREATION INSTRUCTIONS on pages 8-10; follow these instructions carefully. Important 
settings files are included in the enclosed PDF Creation CD. The Color Settings and PDF Export Settings files on 
this CD must be installed if you plan to submit PDF files.

TEST PAGES

Included on the PDF Creation CD you will find a color target test image to include in your test pages. It’s also 
beneficial to include some of your own photos and styled text in these pages for testing. Send 2-4 pages of 
your book with the supplied target test image to graphics@walterspublishing.com 

PDF testing must be done as early as possible and approved before your yearbook can be submitted.

Yearbook Covers
Choose a Stock Cover or Design Your Own Custom Cover.
•   �Custom covers must be submitted before the rest of your book.
•   �Cover deadlines are February 1ST for yearbooks shipping before June 30 and August 1ST for yearbooks 

shipping July 1 to December 31.
•   �Stock covers allow you to print your title in the color shown for FREE. See the Stock Cover Guide for choices. 

Please note: stock cover art cannot be altered.

Page Count

•   �Yearbook page counts must be divisible by 4 (e.g,. 24 or 32 pages, but not 22 or 30 pages). Your total page 	  
count does not include the outside cover, the inside front or inside back cover; only interior pages. 

•   �Smyth Sewn yearbook page counts must be divisible by 16.

Autograph & Current Events Pages
You can add Stock Autograph Pages (extra charge) or Current Events Pages to your yearbook. Indicate your 
design and placement selections on the Production Form. Stock Autograph pages are not included in your 
total page count and are not numbered. Current Events pages should be included in your total page count, 
but will not be numbered. Current Events pages will be added to the back of your book, unless otherwise 
specified on the Production Form. Current Events pages will not be billed separately. Your yearbook price will 
be based on total page count (including Current Events pages).

We cannot process your yearbook without a completed Production Form!

Follow the instructions in this guide carefully. Yearbooks not within these guidelines may be returned 
for rework and will be rescheduled. This will delay shipment.

If you have questions, please contact Customer Care at 1-800-447-3274. We are happy to help! 3
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then set the application preferences listed on the following pages. These guidelines apply to all books.



IMAGE COLOR SPACE No need to 
alter your image color space. If images are RGB, no 
CMYK conversion is needed. Our PDF output settings 
and refining process will convert them to the proper 
color space. Most cameras and scanners include a 
source profile (also known as input profile) when 
saved. We recommend you embed (or tag) the source 
profile to each image. A source profile will define how 
the camera/scanner interprets the colors in the photo 
and make your color conversion clean and effortless.

HOW WILL MY IMAGES LOOK
WHEN CONVERTED TO 
CMYK? Your converted images will look very 
similar to your original RGB files. There is much more 
color information in the RGB color space than can be 
printed with a CMYK profile, but the results have 
been very accurate with the conversion profiles we 
use. If you are concerned about how your images will 
convert, color testing is an option, if requested in 
advance.

FILE FORMATS JPEG (.jpg), TIFF (.tif), 
PNG (.png) and EPS (.eps) are all acceptable file 
formats to use in your yearbook. You choose the 
format when you save your images in the scanning or 
image editing software. JPEG files should be saved at 
a high-quality setting (less compression 10–12) and 
are favored because of their small size. TIFF files must 
be saved with no compression.

IMAGE SCANS For scanned pictures, the 
scan resolution must be set to at least 300 dpi for a 
scan at 100%. If you will enlarge a photo, increase 
the resolution of the scan to compensate. Review the 
other scanner options before you scan your images.

WEB IMAGES Images from the Web will 
have a low resolution of 72 dpi and will print poorly. 
We do not recommend their use. In addition, most 
images found on the Internet are copyright protected.

IMAGE RESOLUTION Resolution is a 
very important factor to consider when looking at 
your digital images. To print an image effectively, it 
needs to have a resolution of between 250 and 300 
pixels per inch (ppi). The image should be the same 
dimensions that you plan to print it in your yearbook 
at a resolution of 300 dots per inch (dpi).

If you want your image to appear 6 inches wide 
on a printed page it’s size should be 6 inches 
multiplied by 300 pixels per inch, (1800 pixels) or 
greater.

Many people try to increase resolution (ppi/dpi) using 
imaging software such as Photoshop®; this usually 
makes the image quality worse. There is only a fixed 
amount of information (pixels) in an image, and by 
increasing the resolution and leaving the image size 
the same, you are asking the software to add more 
pixels to the image. The software is forced to “guess” 
what each added pixel should look like based on the 
other pixels around it, and the image becomes blocky 
or fuzzy. 

Low resolution isn’t inherently bad, but in order to 
achieve print resolution the image should be the 
equivalent of 300 pixels for every inch (ppi). That 
means if an image is only 640 pixels wide to begin 
with, it should probably only be printed at two inches 
wide (640 / 300 is roughly 2+).

Photoshop may tell you your image is 8"x10" at 72 
dpi, which when converted properly for print at 300 
dpi is only 1.92"x2.4"

Digital camera images are often recorded at a low 
resolution (72 dpi), but the image dimensions at that 
resolution will be very large. These images actually 
have the total number of pixels needed to increase 
the resolution to 300 dpi and still maintain 
dimensions (in inches) large enough for your book.

55" at 72 dpi is the same as 13.2" at 300 dpi 
(3960 pixels wide for both).

An 8 megapixel camera shoots images at 3264 x 
2448 pixels.

STOCK ARTWORK Your yearbook 
becomes a unique expression when you creatively use 
stock backgrounds, borders, autograph pages and clip 
art. Our stock artwork has been grouped into series 
according to theme, color and style. Use artwork 
within the same series for a consistent looking 
yearbook. When you choose clip art, less can be 
more—you want the focus to be the photographs.

BACKGROUNDS Add variety to your pages 
with backgrounds. All backgrounds are set up to 
bleed (extend) 0.125" (1/8") beyond page edges. Use 
the program templates to place them correctly and 
avoid correction charges. Or use them with text as 
section dividers in your yearbook. We do not 
recommend color backgrounds for use in black and 
white books as they may not convert well.

BORDERS You can use borders to frame 
pages. Some borders are set up to bleed (extend) 
0.125" (1/8") beyond page edges. Borders that do not 
bleed will have white edges and should be centered 
on the page. Use program templates to place borders 
correctly and avoid correction charges. Or use them 
with text as section dividers in your yearbook. We do 
not recommend color borders for use in black and 
white books as they may not convert well.

AUTOGRAPH BACKGROUNDS 
Place autograph backgrounds in your yearbook 
wherever you would like. They will print on gloss 
paper like the rest of your pages.

CLIP ART Fill in spaces in place of photos or 
enhance your pages with clip art. Choose from a large 
variety! Many pieces of clip art coordinate with 
background sets (see the note in the Clip Art section 
of the Art and Font Guide).

We Are Not responsible for the quality (resolution or color) of your digital yearbook images 

once they have been submitted as PDF files. 4
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best results from your images and publish a spectacular-looking yearbook! Be sure to consider the following 
when choosing images to include in your yearbook:

Artwork adds an extra dimension to your yearbook. We provide a variety of fun and colorful stock artwork files 
for your book. Choose from backgrounds, borders, autograph pages and clip art. The Artwork DVD is located 
on the inside back cover of this guide. 

If you have concerns about your images, contact us at 1-800-447-3274 to 
discuss possible solutions and/or perform image testing.

CONCERNS?



STOCK ARTWORK Your yearbook 
becomes a unique expression when you creatively use 
stock backgrounds, borders, autograph pages and clip 
art. Our stock artwork has been grouped into series 
according to theme, color and style. Use artwork 
within the same series for a consistent looking 
yearbook. When you choose clip art, less can be 
more—you want the focus to be the photographs.

BACKGROUNDS Add variety to your pages 
with backgrounds. All backgrounds are set up to 
bleed (extend) 0.125" (1/8") beyond page edges. Use 
the program templates to place them correctly and 
avoid correction charges. Or use them with text as 
section dividers in your yearbook. We do not 
recommend color backgrounds for use in black and 
white books as they may not convert well.

BORDERS You can use borders to frame 
pages. Some borders are set up to bleed (extend) 
0.125" (1/8") beyond page edges. Borders that do not 
bleed will have white edges and should be centered 
on the page. Use program templates to place borders 
correctly and avoid correction charges. Or use them 
with text as section dividers in your yearbook. We do 
not recommend color borders for use in black and 
white books as they may not convert well.

AUTOGRAPH BACKGROUNDS 
Place autograph backgrounds in your yearbook 
wherever you would like. They will print on gloss 
paper like the rest of your pages.

CLIP ART Fill in spaces in place of photos or 
enhance your pages with clip art. Choose from a large 
variety! Many pieces of clip art coordinate with 
background sets (see the note in the Clip Art section 
of the Art and Font Guide).

CUSTOM ARTWORK You may choose 
to include custom artwork in your book. Please follow 
the same guidelines as with stock artwork. Full page 
backgrounds should be saved at 8.75"x11.25" at 300 
dpi. Bleeds must extend 0.125" (1/8") beyond page 
edges on all sides. We recommend you choose 
artwork that creates a coordinated look throughout 
your entire yearbook. See page 4 for accepted file 
formats.

COPYRIGHTED MATERIAL 
Walter’s Publishing reserves the right to refuse to 
print any materials provided by its customers for 
any reason, including, but not limited to, materials 
determined by Walter’s Publishing, at its discretion, to 
be offensive, illegal, or in violation of any copyright or 
other proprietary rights. By submitting an order, and 
providing photos, trademarks, tradenames, images or 
other content (collectively, the “Customer Content”) 
to Walter’s Publishing, the Customer represents 
that it has the right to have the order printed, with 
the inclusion of the Customer Content, and that 
printing of the order by Walter’s Publishing, and the 
use of the Customer Content, will not infringe the 
intellectual property right of any third party. Customer 
will defend, indemnify and hold harmless Walter’s 
Publishing from any claims, costs, losses, and liability 
(including reasonable attorney’s fees and expenses) 
arising out of or related to the Customer Content 
or the production of the Order as directed by the 
Customer.
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Images are the MOST important part of your yearbook project. The following information will help you get the 
best results from your images and publish a spectacular-looking yearbook! Be sure to consider the following 
when choosing images to include in your yearbook:

Artwork adds an extra dimension to your yearbook. We provide a variety of fun and colorful stock artwork files 
for your book. Choose from backgrounds, borders, autograph pages and clip art. The Artwork DVD is located 
on the inside back cover of this guide. 
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GETTING STARTED
How do we PUT OUR BOOK TOGETHER? 
Determine the approximate number of pages you 
will need in the book, based on the number of 
students and staff members, number of grades, 
extracurricular activities and other pages you might 
want in the book. If you plan to use portraits from 
your school photographer, contact the photographer  
at the beginning of the school year. Arrange to have 
your portraits available as early as possible, as you 
will need them to begin page layout. 

What steps should we take to ASSEMBLE 

OUR BOOK?  
First, have your photographer supply you with high-
resolution digital files.

Then, use this guide and the other resources 
included in your yearbook kit to help you create your 
yearbook. 

How Do we GET OUR BOOK PRINTED? 
Complete the Yearbook Checklist found on the PDF 
Plan Production Form. Gather all the publication 
materials and send them to us.

COVER SET-UP
May we DESIGN OUR OWN COVER? Yes, but this 
may be an additional charge— contact your sales 
representative for more information. Custom covers 
must be submitted with the completed Custom 
Cover Form by February 1 (for yearbooks shipping 
before June 30). For Fall delivery yearbooks (delivered 
by December 31), cover files must be submitted by 
August 1. Production cannot begin unless the 
Custom Cover Form has been fully completed and 
artwork is acceptable.

May we CUSTOMIZE THE BACK COVER? 
Yes, if you are creating a custom cover. Stock covers 
can only be imprinted in the logo area on the back.

May we PRINT ON THE INSIDE OF THE COVER? 
Yes, you can print on the inside of soft cover 
yearbooks, or design endsheets for a hard cover 
yearbook. There is an additional charge for this. 
Contact your yearbook representative for more 
information.

TEMPLATE OPTIONS
Are we required to use the TEMPLATES AND

ARTWORK provided on the CD/DVD? How many

FONTS can we use? 
You may create your own templates and use any 
custom artwork that follows our guidelines. You may 
use any of the fonts provided on the Artwork DVD 
free of charge. PDF books may use an unlimited 
number of fonts, as long as they are embedded 
correctly (see the PDF Creation section of this 
guide—pages 8-10).

How do we ACCESS THE TEMPLATE LIBRARIES

provided on the PDF Creation CD?  
In InDesign, go to the File menu and select Open. 
Locate the loaded CD and choose the desired library.

May we MODIFY THE TEMPLATES? 
Yes. You may alter them, but keep images and text 
within the .5" (1/2") page margins.

May we SELL AD SPACE to help fund our

yearbook? Do you have AD TEMPLATES? 
Yes, you can use our templates, which allow from 
one to eight ads per page (see candid template 
section), or create your own ad pages. 

YEARBOOK LAYOUT
Do we NEED TO KNOW A LOT ABOUT COMPUTERS? 
You should be familiar with your hard drive, the 
programs you are using, and how and where to 
save images.

What PROGRAMS may we use? 
InDesign® (CS3 or higher) or Photoshop®. Knowledge 
of Photoshop is required if you plan to scan or resize 
images. Other programs may be used to create PDF 
files but we support only the programs listed above. 
If you are using another program to create your files, 
please contact our graphics department with 
questions and to submit a test. E-mail 
graphics@walterspublishing.com.
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How do we BEGIN CREATING OUR BOOK? 
Start by reading the entire PDF Instruction section in 
this book. InDesign users should install the document 
preset (instructions on page 9). Load and activate 
color profiles and PDF export settings; follow 
instructions on pages 8-10.

May we design our yearbook in a FACING 

PAGES LAYOUT? 
Yes. Make sure the bleeds are extended on all four 
sides. Convert your book to PDF files as single pages, 
and e-mail a PDF test to us before submitting the 
files for publishing. For more information contact  
graphics@walterspublishing.com

May we include a TWO-PAGE CLASS PICTURE

SPREAD in our book? 
Yes, a two-page class picture spread can be printed 
in your yearbook. Set it up like any other page in 
your book that bleeds, making sure the images meet 
correctly in the center of the two pages.

How should we SAVE OUR YEARBOOK FILES? 
A PDF book may be submitted in whatever section 
sizes you would like (1 page, 4 pages, 16 pages, 
entire book). PDF files should be named in a manner 
that clearly indicates the job number and page 
number; e.g., jobnumber_001-016.pdf.

How do we CREATE A PDF of our yearbook? 
Install the PDF Export Options from the PDF Creation 
CD included in this guide. Follow the PDF Creation 
Guide instructions that pertain to the programs that 
you are using to create your yearbook.

IS SUPPORT AVAILABLE if we encounter problems

or have questions? 
Yes, phone and e-mail support is available. We will 
gladly help you with questions regarding preferences, 
requirements, artwork, templates and image quality. 
Contact graphics@walterspublishing.com. 

However, we offer limited computer support and 
are not staffed to instruct first-time program 
users. For questions about computer programs, it’s 
best to seek help on the Internet or in your 
program’s user guide.

IMAGE CONCERNS
DO IMAGES NEED TO BE IN CMYK MODE or may we

submit them in RGB mode? 
Images can be submitted to us in either RGB or 
CYMK mode. Make sure that you attach the input 
color profile, especially if you converted images from 
RGB to CMYK.

WHAT RESOLUTION should images be? 
Every image should be at least 300 ppi/dpi (pixels per 
inch/dots per inch) at the actual dimensions the 
image will appear in your yearbook. You can check 
this in Photoshop under “Image” and “Image Size.”  
For more information, see page 4.

May we include PICTURES FROM MAGAZINES, MUSIC

CD COVERS OR STICKERS in our yearbook? 
It is not legal to publish any previously published 
(copyrighted) material unless you have supplied a 
release signed by the copyright owner. Only if you 
have been given permission may you include them.

How can I find out who owns a copyright? 
Some investigative work will be required. If the 
copyright owner is not listed outright on the work 
you wish to copy, you may need to directly contact 
the publisher of the work where you viewed the 
image to see if they know who the copyright owner 
would be. For web pages, you may need to contact 
the webmaster of the site or the company that 
produced it. For books it is recommended to contact 
the publisher. Walter’s Publishing cannot provide 
copyright advice for you. It is your responsibility to 
do the necessary due diligence and retain proper 
documentation of permissions. 

In most cases it is easy to obtain permission from 
companies for logos and images by simply contacting 
them. Most professional clip art packages allow 
reproduction rights for the files you purchase. Other 
sources such as Getty Images (www.gettyimages.
com), Landov (www.landov.com) or other image 
providers have special rates for schools purchasing 
photos for reproduction in yearbooks. You may also 
search for “Public Domain” images, which have 
limited or no rights restrictions.

You should begin the research immediately if you 
know you have possible copyrighted images.

For disclaimer information, see page 5.
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discuss possible solutions and/or perform image testing.
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GETTING STARTED

FIRST  Install Color Profile, Color Settings and PDF Preset

•   �Make sure all the applications that you will be using to create your book are installed on your computer and 
confirm that they are all closed. 

•   �Insert the PDF Creation Installation CD

•   �Follow the detailed instructions on the following pages.

SECOND  Create PDF Test Files

•   �Use one of the Document Templates located on the PDF Creation CD to create two or three PDF test pages.

•   �Include fonts and images you plan to use in your finished book.

•   �Include the WP_Color_Target.tif file located on the PDF Creation CD in one of your test pages.

•   �Also Include a bleed (background color or image that extends 0.125" beyond the document edge on all four 
sides) on one of your test pages.

•   �E-mail your test PDF to graphics@walterspublishing.com. PDF test files need to be submitted at least 4 
weeks prior to book submission. If your PDF files are too large to email, FTP instructions can be requested 
by contacting graphics@walterspublishing.com

We will preflight your PDF test files to ensure that page size and bleeds are set up correctly, fonts have been 
embedded, and image resolution is high enough to reproduce in print without looking pixelated or blurry.

If preflight problems are found, you will be notified and your book will be placed on hold. This could 
possibly delay the delivery of your book. 

To avoid this, remember to send in your PDF test pages!

THIRD  Design Your Book

Once your PDF test pages have been approved, start designing your book. Have fun with it—be creative! 
When you generate the final PDF file(s) of your book, it is very important that you use the same computer and 
settings you used for testing. If, for any reason, the PDF of the final book will be generated from a different 
computer, or the applications have been reinstalled, you must follow the first and second steps above on the 
new computer, and resubmit PDF test files for approval a second time to prevent delays once your finished book 
has been submitted for publishing.
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applications, along with turning on the appropriate color settings for these applications. These settings will allow 
the programs you use to produce the best possible color conversion while showing you, as closely as possible, 
what your images will look like when printed on a 4-color process printing press.

Email your PDF test pages to graphics@walterspublishing.com before 
you start creating your book!

DON’T FORGET!
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The following pages will guide you through loading our color profile and PDF export preset to your Adobe 
applications, along with turning on the appropriate color settings for these applications. These settings will allow 
the programs you use to produce the best possible color conversion while showing you, as closely as possible, 
what your images will look like when printed on a 4-color process printing press.

STEP 1. Install The Color Profile

Insert the PDF Creation CD into your Computer’s Optical 
Drive. If your computer does not have a CD or DVD drive 
you can download all the files you’ll need at  
www.pictavo.com/pdf-downloads.

On your computer, navigate to: PDF Creation CD / Color 
Profile / GRACol2006_Coated1v2.icc

In Windows, right-click the .icc file on the PDF Creation 
CD and select Install Profile. 

Alternatively, copy the profiles into:

WINDOWS\system32\spool\drivers\color folder.

In Mac OS, copy the .icc file on the PDF Creation CD to:  
/Library/ColorSync/Profiles or  
/Users/[username]/Library/ColorSync/Profiles.

After installing color profiles, be sure to restart your 
Adobe applications.

STEP 2. Install COLOR SETTINGS

A. Open Adobe InDesign or Photoshop. Be sure all  
	 documents are closed. 

B. Choose Edit > Color Settings to open the Adobe  
	 Color Settings Dialog Window.

C. Click the Load button in the Color Settings Window 
	 and navigate to: PDF Creation CD / Color Settings File /  
	 CGC_ColorSettings_WP.csf

D. Make sure the new CGC_ColorSettings_WP setting is  
	 selected at the top of the Color Settings Dialog  
	 Window and click OK. (The Window will Close).

STEP 3. Install PDF Export Preset

A. Open Adobe InDesign or Photoshop. 
Be sure all documents are closed. 

B. In Photoshop Choose Edit > Adobe PDF Presets to  
	 open the PDF Presets Dialog Window. 
	 In InDesign Choose File > Adobe PDF Presets >  
	 Define... to open the PDF Presets Dialog Window.

C. Click the Load button in the PDF Presets Window and  
	 navigate to: PDF Creation CD / PDF Export Preset /  
	 CG_pdfx4.joboptions.

D. Click Done to close the PDF Presets Window.

Note: The Color Settings and Adobe PDF Presets windows may look different depending on the Adobe program, 
version, and computer OS, but the content and buttons should be the same.

Windows & Mac Explorer and Finder windows

Adobe Photoshop Color Settings window (Mac)

Adobe PDF 
Presets windows 
for Photoshop & 
InDesign (Mac)
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STEP 4.  CREATE YOUR PDF
When you are ready to create your PDF test pages, or your 
final PDF’s to send in you will Export your working Photoshop 
or InDesign Document to PDF.  
Before you do this, save your work as native Photoshop 
or InDesign Files. This will ensure you can go back to your 
work and make additional edits or changes if necessary.

In Adobe Photoshop: 

A. Click File > Save As to open the Save As Dialog WIndow.

B. In the Format: Drop Down Menu choose: Photoshop PDF.

C. �Name your file as follows: jobnumber_pagenumber(s).pdf. 
(ie. 65003_018.pdf, or 65003_001-098.pdf for multiple  
pages). Make sure to create a folder in a location that will  
be easy for you to find later.

D. �Make sure Embed Color Profile is checked, and click 
Save.

E. �If a color setting warning box appear, click OK to load the 
Save Adobe PDF Window.

F. �In the Adobe PDF Preset: Drop Down Menu choose: 
CG_pdfx4 then click Save PDF.

In Adobe InDesign:

A. Click File > Export to open the Export window.

B. �Name your file as follows: jobnumber_pagenumber(s).pdf. 
(ie. 65003_018.pdf, or 65003_001-098.pdf for multiple  
pages). Make sure to create a folder in a location that will  
be easy for you to find later.

C. �Choose Adobe PDF (Print) from the Format Drop Down  
Menu and click Save to open the Export Adobe  
PDF window.

D. �In the Adobe PDF Preset: Drop Down Menu choose: 
CG_pdfx4, then click Export.
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Adobe Save As window for Photoshop (Windows)

Adobe Save As PDF window for Photoshop (Mac)

Adobe Export PDF window for InDesign (Mac)Adobe Export window for InDesign (Windows)

Note: The Save and Export PDF windows may look different depending on the Adobe program, version, and 
computer OS, but the content and buttons should be the same.
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CREATE A THEME
Developing a theme for your book can be easy and fun when you have great options like what’s provided on 
the included artwork and font DVD. Our backgrounds and clip art coordinate together with many of our stock 
covers, or can even inspire your own custom cover and art.  

We include over 70 unique fonts to choose from so you can be sure your book has a style and class all it’s own. 
You can look through everything we include on the DVD in our Art & Font Guide. 

PLAN YOUR PAGES
Planning every section of your book will help make sure you’re including everything, along with tracking your 
progress as you create. Using a ladder to outline your book is an effective way to help you plan all your pages.

•	Work	in	increments	of	4	pages	unless	you	a
re	doing	

	 a	Smyth	Sewn	book	where	you’ll	need	t
o	work	in	

	 increments	of	16	pages.	

•	Create	a	list	of	contents	organized	by	se
ctions	

	 (portraits,	student	life,	sports,	academics
,	etc.)	to	help	

	 determine	your	approximate	number	of	
pages.	

•	Keep	in	mind	your	yearbook	delivery	dat
e	to	determine	

	 what	you	can	include	and	what	you	ma
y	need	to	put	

	 into	a	supplement.	

•	Factor	in	proofing	of	pages	and	addition
al	edits	when	

	 creating	your	deadline(s).	Consider	addi
ng	an	initial	

	 deadline	for	review	and	final	deadline	wh
en	edits	are	

	 to	be	complete.	

•	Use	colors	to	code	things	like	deadlines
,	assigned	to,	

	 items	completed/submitted,	etc.

Tips

WP4304_Wall-Ladder-2.indd   1
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L A D D E R  W O R K S H E E T
Before diving into your book project, plan what is to appear on each page by filling out this ladder worksheet. 
Doing so will help you to visualize what will appear on each page and assist in creating a natural ‘flow’ for your book.

WP4308_LADDER_WKSHT.indd   1 7/2/13   9:56 AM

Adobe Save As window for Photoshop (Windows)

Adobe Save As PDF window for Photoshop (Mac)



PRODUCTION FORM
Completely fill out and sign the Production Form. 
We cannot begin processing your book without it!  
If you have copyrighted information in your book, 
submit written, verifiable permission for use with your 
Production Form.

SEND IN YOUR BOOK
When your book is finished and your PDF(s) are 
created, save your files to CD, DVD or USB drive to 
send in.

ITEMS TO SEND
1. A completed Production Form.

2. �The PDF file(s) on CD, DVD or USB drive. A printed 
hard copy should also be submitted with your  
digital files.

3. Custom covers must be submitted with the  
	 completed Custom Cover Form by FEBRUARY 1ST  
	 for yearbooks shipping before June 30TH.  
	 AUGUST 1ST for yearbooks shipping July 1ST to  
	 December 31ST.

WHERE TO SEND
Please refer to your yearbook or military book 
provider for the appropriate mailing address to send 
the above items.

UPON ARRIVAL
All PDF books will be screened upon arrival to ensure 
you have followed our guidelines. Any problems and 
charges will be noted and we will contact you to 
discuss how to resolve the problems. We reserve the 
right to return any PDF job which does not follow our 
specifications. We also reserve the right to make 
any corrections that total $100 or less without 
prior notification.

Please note that in the event a hard copy is submitted 
and there is a discrepancy between the hard copy and 
the PDF, the PDF document will be considered the 
correct version of the document.

BOOK PROOF 
You should keep a copy of the digital files you 
submit. If you would like a printed proof, arrange this 
ahead of time so your book can be scheduled 
accordingly. Proofs are $0.50 per page (minimum of 
$25) plus shipping. Receiving a printed proof of the 
book adds 2 weeks to production time.

DELIVERY TIME
Please allow 4-6 weeks (4 weeks for soft saddle,  
6 weeks for soft perfect, standard hard cover and 
Smyth sewn) from the date we receive and 
approve your PDF files and the yearbook passes 
preflight to the date your books are shipped. Allow 
up to 5 business days for delivery. Delivery dates are 
based on reservation or by available dates if no 
advance reservation is in place.

COMPLETED BOOK
We hope you enjoyed the process of creating a 
yearbook with us. It will be a memento of a year to 
remember…full of memories, friends, great times and 
unforgettable pictures!
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Once you have completed the steps to prepare your yearbook pages, submit all of your materials—along with 
your completed Production Form—for printing. Once we receive your book, we will preflight for potential 
problems. Remember that test files should have been submitted immediately after receiving the PDF 
Creation Guide Instructions.
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WP6325

Don’t Be Caught Short!

NOTE: Substantial charges and 

ship date delay may apply if this 

form is not followed or complete.PDF BOOK
S U B M I S S I O N  C H E C K L I S T

   Custom cover (if applicable) has been furnished in a separate file and submitted by February 1st (unless sign-up was  

after that date).

  Page numbers are on every page (or at least every other page). This is required!

  The borders and backgrounds that are to bleed have been placed at .125 inch beyond all page edges  

 (X: -.125 / Y: -.125).

   Images and text have been kept within the .5 inch page margins so they will not be trimmed off or tucked   

into the spine during book binding.

 Font menu styles have not been used (ex. bold or italic) unless the actual bold or italic version has been  

 provided. Artificially bolded and italicized fonts will not embed correctly (PC only).

  I have proofed the book for corrections. I have made any corrections and changes before submitting the 

 book for publishing. I will not receive a proof unless previously arranged.

  This PDF Production Form has been fully completed and, if applicable, copyright permission has  

 been attached.

  I have included a hard copy and electronic file for personalization of my books, if applicable.

 
  PDF Creation Guidelines have been followed in order to create PDF files to the required specifications.

   Documents have been PDF’d in single page layouts, not facing pages (spreads). PDF files can be submitted in 

whatever section sizes you would like (1 page, 4 page, 16 page, entire book). Be sure to name PDF files with your job 

number and with what pages they are in the book (for example: 33333_001-016.pdf).

  A test file has been previously submitted/emailed to graphics@walterspublishing.com and has been approved.  

 PDF testing should be completed at least 4 weeks before final PDFs are submitted!

   I understand the electronic PDF submitted will serve as the proof. In the event a hard copy is submitted and   

there is a discrepancy between the hard copy and the digital PDF file, the digital PDF will be considered the correct   

version of the document.

T  his checklist must be read, checked, signed, and dated in order for your yearbook to be processed. If 

you have checked all of the items and signed this form, we consider your book ready to print AS IS. 

If there are problems with any of the items you have checked, you will be notified as soon as possible.

*Please read and check each item:

I have read, understand, and agree to the above.                      
     

Signature:_____________________________________________________ Date:_______________

a

Production Form

Job#:_______________

             i  IMPORTANT HINT      

Make sure to order a few extra books for those that would appreciate a yearbook.  

Perfect For:  • The student that forgot to order   • Thank you gift for a dedicated Yearbook Adviser or Supporter 

• Ideal keepsake gift for a special retiring faculty or staff member  • Place a copy in your school library 
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